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1. ЗАДАНИЕ
Лабораторная работа №6 «Прямое и обратное проектирование» по курсу «Технологии разработки программного обеспечения».
1.1. Цель работы

· Изучить унифицированный процесс разработки (RUP);

· Приобрести умения построения модели проектирования и процессов прямого и обратного проектирования;

· Получить навыки построения модели проектирования и процессов прямого и обратного проектирования в среде Sparx Enterprise Architect.
1.2. Средства выполнения
· Sparx Enterprise Architect [1].
1.3. Продолжительность работы
Время выполнения лабораторной работы 4 часа.

1.4. Пункты задания для выполнения

1. Открыть в среде Enterprise Architect проект, созданный ранее. 

2. Установить для проекта профиль языка программирования, который будет использоваться при обозначении типов данных и генерации кода.
3. Создать диаграмму трассировки граничных классов в классы форм.

4. Создать диаграмму трассировки управляющих классов в классы проектирования [2]. Создать подсистему (package) и переместить туда полученные классы.
5. Выполнить прямое и обратное проектирование package подсистемы (сгенерировать код, изменить код, синхронизировать).

6. Создать диаграмму трассировки пакетов анализа в подсистемы.

7. Создать инфологическую модель.

8. Создать диаграмму трассировки классов сущностей в сущности инфологической модели.

9. Сгенерировать даталогическую модель на основе инфологической модели.

10. Сгенерировать DDL-сценарий на основе даталогической модели.

11. Сгенерировать документацию проекта.
12. Выполнить проверку целостности проекта.

13. Получить краткую статистику проекта.

14. Построить и изучить шаблон проекта базы данных (DDL, документация).
1.5. Содержание отчета
· Титульный лист;

· Цель работы;

· Задание;

· Диаграммы трассировки классов анализа в классы проектирования;

· Описание классов проектирования, их атрибутов, операций и их параметров;
· Диаграмма трассировки пакетов в подсистемы;

· Инфологическая и даталогическая модель (диаграммы);

· DDL-сценарий;

· Пример документации проекта (скриншот);

· Результат проверки целостности проекта;

· Краткая статистика проекта;
· Шаблон проекта базы данных (содержание);

· Вывод;
· Список используемой литературы.

2. ВЫПОЛНЕНИЕ РАБОТЫ
2.1. Обозначение профиля ЯП для проекта
Определение языка программирования (ЯП), который будет использоваться при разработке, необходимо для того, чтобы в дальнейшем на диаграммах использовались те типы данных, которые поддерживаются данным языком, а также чтобы на требуемом языке выполнить генерацию кода по построенной диаграмме.
2.1.1. Установка ЯП для проекта или класса
Определить ЯП можно:

· На уровне проекта:

Для этого необходимо перейти в пункт Configure>Model>Options>Source Code Engineering, выбрать ЯП из выпадающего списка в Default Language for Code Generation. Для примера будем использовать язык C++, он наиболее подробно описан в среде Enterprise Architect.
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Альтернативно можно включить плавающее окно выбора ЯП. Для этого перейти Start>Desktop>Preferences>Other Options>Toolbars и выбрать Code Generation.
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После этого появится небольшое окно, в котором можно управлять выбор ЯП и автоматической генерацией кода.
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· На уровне класса:
В таком случае можно выбирать ЯП для каждого конкретного класса на диаграмме. Для этого кликнуть ПКМ по существующему классу и выбрать пункт Properties>Properties… На вкладке General справа можно выбрать ЯП, который будет использоваться при описании класса.

2.2. Отображение типов данных и стереотипов

После выбора ЯП можно заметить, что набор типов данных для атрибутов и методов соответствует данному ЯП. Рисунок ниже демонстрирует выбор типов данных для класса на языке C++.
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Если выбрать другой ЯП, то список возможных типов данных также поменяется. Ниже представлен список типов данных для класса на языке C#. Обратите внимание, на новые типы данных.
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Также для классов можно обозначить стереотипы, которые поддерживает определенный ЯП. Для этого кликнуть ПКМ по существующему классу и выбрать пункт Properties>Properties… На вкладке General справа кликнуть по «…» по пункту Stereotype. В открывшемся окне можно выбрать ЯП из выпадающего списка Profile. Для выбранного ЯП отобразится список поддерживаемых стереотипов.
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2.3. Трассировка классов
Классы анализа трассируются в классы проектирования. При этом классы проектирования описываются с учетом особенностей языка программирования и разрабатываемого проекта: 
· Точное указание типов данных;
· Соблюдение стереотипов;
· Указание параметров методов;

· Точное указание доступности (scope) методов и атрибутов;
· Написание названий элементов на латинице предпочтительно с соблюдением правил написания названий элементов (camelCase, snake_case и т.п.)

2.3.1. Трассировка управляющих классов

Ниже представлен пример трассировки (стереотип связи «trace») управляющего класса анализа в класс проектирования.
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2.3.2. Трассировка классов сущностей
В рамках данной лабораторной работы классы сущности трассируются в сущности инфологической модели. Описание построения инфологической модели приводится в следующем разделе. Ниже представлена трассировка классов сущностей в заранее полученные сущности инфологической модели.
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Также классы сущностей могут трассироваться классы проектирования с учетом создания не только отдельного класса, но и таблицы в БД.
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Создание таблицы на диаграмме классов проихсодит следующим образом: перенести на диаграмму пустой класс, выбрать для него стереотип «table», применить изменения (отменить выделение и заново выделить класс). Теперь вместо возможности добавлять атрибуты и методы у этого класса будет доступна только возможность добавления колонок (Column).
2.3.3. Трассировка граничных классов

Граничные классы трассируются в формы пользовательского интерфейса и элементы этих форм, каждые из которых представлены на диаграмме отдельными классами.
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2.4. Прямое и обратное проектирование
В данном разделе под прямым проектированием имеется в виду генерация кода из содержимого диаграммы, а обратное проектирование – обновление диаграммы в соответствии с изменениями, внесенными в код.

Реализуем прямое и обратное проектирование на примере двух классов: Class1 и Class2. Class1 связан с Class2 отношением наследования (Generalization). Данные классы были созданы на отдельной диаграмме, а затем были перенесены в заранее созданный пакет test_subsystem.
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Выполним генерацию кода по данным классам – прямое проектирвоание. Для этого необходимо перейти в пункт меню Develop>Source Code>Generate>Generate All.
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Далее необходимо выбрать папку, в которую будут сохраняться программные коды.
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В результате будет выведен лог-файл результатов генерации.
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Откроем файл, найдя его в проводнике.
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Видно, что код был сгенерирован с соблюдением синтаксиса языка C#, а также с учетом всех указанных методов, связей наследования и т.д. Также были созданы конструкторы и деструкторы.
В качестве пространства имен используется название пакет, в котором расположены классы – test_subsystem.
Выполним обратную операцию. Запишем в коде новый метод и атрибут в класс Class1, а в Class2 наоборот удалим один из атрибутов.
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Теперь выполним обратное проектирование – для этого в меню выбрать Develop>Source Code>Synchronize> Synchronize Package... В открывшемся окне оставим настройки по умолчанию, затем согласиться с синхронизацией элементов. В итоге можно увидеть, что в классе Class1 появились те самые новые элементы с соблюдением типов данных и области доступности. 
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2.5. Трассировка пакетов в подсистемы

Подсистемы прикладного уровня определяют на основе пакетов анализа. Изначально пакеты анализа транслируются в подсистемы проектирования прикладных уровней, сервисные пакеты — в сервисные подсистемы. 

Далее проводят уточнение и декомпозицию полученных подсистем по следующим правилам:

· часть пакета анализа, совместно используемую несколькими подсистемами, выделяют в отдельную подсистему;

· часть пакета анализа для многократного применения выделяют в отдельную подсистему, в том числе подсистему среднего уровня или уровня системного ПО;

· унаследованные подсистемы выделяют в отдельные подсистемы;

· выполняют декомпозицию подсистем для возможности разделения работ;

· осуществляют декомпозицию подсистем в целях разнесения их по узлам так, чтобы каждая подсистема была на отдельном узле.

В результате трассировки пакетов анализа в подсистемы была сформирована диаграмма трассировки.
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2.6. Создание инфологической модели
2.6.1. Создание вручную

Для создания инфологической модели вручную необходимо создать диаграмму классов и расположить на ней элементы-классы с соответствующими стереотипами:
· Сущность – стереотип «ERD_Entity»;
· Атрибут – стереотип «ERD_Attribute»;
· Связь между атрибутом и сущностью – стереотип «ERD_Connector»;
· Связь между сущностями – стереотип «ERD_Relationship».
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При применении стереотипов классы будут автоматически визуально изменяться в соответствии с нотацией ER-диаграммы.

Все элементы связываются связью Association из пункта Class Relationships в Toolbox.

Для обозначения того, что атрибут является первичным ключом, необходимо в окне Properties установить соответствующее значение attributeType.
[image: image21.png]Properties v R x
H=-#

tenent Tags
Name na
o)
pe 0 Atbute
Steotpe r0seRo.Atibute
s
Kepwords
Satos poposed
veson 10
+ eRD_ bt (trom ERD)
BB primiey &
commorDatatype | nomat
aomsDatarype  [Brmamke
o mottivaies

derived

Abstract





Для связей необходимо обозначить множественность, а также дать название каждой связи (внутри ромба на данной связи). Множественность также обозначается в окне Properties выбранной связи во вкладках Source и Target.
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В итоге может быть получена простейшая инфологическая модель.
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2.6.2. Генерация из диаграммы классов модели требований

ER-диаграмму можно сгенерировать автоматически из уже созданной в процессе выполнения лабораторной работы №4 диаграммы классов. Ниже представлен пример такой диаграммы классов.
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Также для генерации инфологической модели подойдет диаграмма классов сущностей.
Для генерации ER-диаграммы из данной модели нужно выполнить следующие действия:

1. Выбрать в проводнике нужный package с диаграммой классов.

2. Перейти в пункт Design>Tools>Transform>Apply Transformation…
3. В открывшемся окне убедиться, что выбраны все классы диаграммы. Затем из списка возможных трансформаций выбрать Data Modeling to ERD. В открывшемся доп. окне выбрать целевой package, куда будет сохранена новая диаграмма и ее элементы.
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4. Нажать Do Tranform.
В указанной целевой папке появится package, повторяющий название диаграммы и оканчивающийся на _ERDiagram. Обратите внимание, что, несмотря на наличие названия у связи Пользователь-Объявление на диаграмме классов, на инфологической модели связь не имеет названия (ромб пустой).
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2.6.3. Генерация из даталогической модели

Пусть имеется следующая даталогическая модель:
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Генерация инфологической модели выполняется аналогичным образом, описанным в пункте выше:

1. Выбрать в проводнике нужный package с диаграммой классов.

2. Перейти в пункт Design>Tools>Transform>Apply Transformation…
3. В открывшемся окне убедиться, что выбраны все классы диаграммы. Затем из списка возможных трансформаций выбрать Data Modeling to ERD. В открывшемся доп. окне выбрать целевой package, куда будет сохранена новая диаграмма и ее элементы.
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4. Нажать Do Tranform.

В указанной целевой папке появится package, повторяющий название диаграммы и оканчивающийся на _ERDiagram. Обратите внимание, что атрибуты, являющиеся первичными ключами в даталогической модели, будут отображаться подчеркнутыми в инфологической модели в соответствии с нотацией данной диаграммы.
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2.7. Создание даталогической модели
2.7.1. Генерация из инфологической модели
Инфологическая модель была предварительно. 
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Обратите внимание на связь М-М между Пользователем и Заказом. В данном пункте работы это изменение было внесено специально. Далее будет продемонстрировано, что на даталогической модели такая связь будет трансформирована в связующую таблицу для разрешения проблемы невозможности связи М-М в даталогической модели.
Для генерации требуется выполнить следующие действия:

1. Выбрать в проводнике нужный package с инфологической моделью.

2. Перейти в пункт Design>Tools>Transform>Apply Transformation…
3. В открывшемся окне убедиться, что выбраны все классы диаграммы. Затем из списка возможных трансформаций выбрать ERD to Data Modeling. В открывшемся доп. окне выбрать целевой package, куда будет сохранена новая диаграмма и ее элементы.
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4. Нажать Do Tranform.

В указанной целевой папке появится package, повторяющий название диаграммы и оканчивающийся на DataModeling. Обратите внимание, что связь М-М между Пользователем и Объявлением превратилась в отдельную таблицу с названием связи «Оформляет». Если бы название связи не было указано, то таблица называлась бы JoinПользовательToЗаказ.
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Для изменения типов данных в таблицах необходимо выбрать СУБД, это делается по клику по любой таблице.
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Для дальнейшей работы с данной моделью необходимо добавить хотя бы один атрибут в таблицу, созданную для разрешения конфликта связи М-М «Оформляет». Добавим поле «Дата». Автоматически внесены ограничения Foreign Key.

Также необходимо обозначить типы данных и дополнительно добавить свой первичный ключ для таблицы «Оформляет».
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2.7.2. Создание вручную
Создадим даталогическую модель (модель базы данных) вручную. Для этого в Model Wizard необходимо создать диаграмму Data Modeling из набора Extended. Также до данной диаграммы можно добраться, выбрав из выпадающего списка наборов Database Engineering.
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На диаграмме, используя элемент Table из Toolbox, постройте все необходимые таблицы и наполните их атрибутами, указав также первичный ключ и типы данных.
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Теперь настроим связи между таблицами. Настроим связи-ассоциации, укажем множественность и ключи, по которым связываются таблицы:
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Таким образом, мы получили модель базы данных с указанием множественности, атрибутов таблиц и их ограничений.
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2.8. Генерация DDL-сценария

Пусть имеется следующая даталогическая модель (модель базы данных):
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Для генерации DDL-сценария необходимо выполнить следующие действия:

1. Выбрав в обозревателе нужную диаграмму, перейти в Develop>Data Modeling>Generate.

2. В появившемся окне указать путь до будущего файла DDL-сценария.
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3. Нажать Generate.
В результате получен файл с PostgreSQL-скриптом создания указанных таблиц и ограничений к ним.
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2.9. Генерация документации

Enterprise Architect располагает широкими возможностями по документированию проекта и автоматическому созданию документации. Для того, чтобы сгенерировать документацию нужно перейти в пункт Publish > Model Reports > Report Builder > Generate Documentation > Generate.
Введите необходимую информацию в открывшемся окне, нажмите кнопку Generate и дождитесь окончания. Обратите внимание, что документацию можно генерировать не только для всего проекта, но и для отдельных пакетов (package).
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Результирующую документацию можно открыть в проводнике и изучить.
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В Приложении 1 представлено описание всех пунктов настройки генерации документации.
2.10. Проверка целостности данных проекта

Репозиторий (проект), созданный в Enterprise Architect, хранится как реляционная база данных [3]. Независимо от используемого ядра базы данных (MS Jet для EAP, MS SQL, MySQL, Oracle или других файлов) для хранения моделей используется одна и та же схема базы данных. Данные реляционной базы данных должны быть непротиворечивыми.

Эта непротиворечивость может быть обеспечена техническим способом путем введения определенных ограничений, после чего механизм базы данных обеспечивает соответствие определенным правилам.

Если репозиторий содержит данные, которые не согласуются с программой EA, EA не информирует нас сообщениями об ошибках. EA просто представляет данные как можно лучше. Вероятно, в коде есть механизмы для отображения или даже изменения таких данных.

Несоответствия в репозитории могут отрицательно сказаться на производительности, что может ощущаться в более сложных операциях, таких как, например, сравнение моделей.

Данную функцию проверки целостности следует использовать в основном при наличии общего репозитория, а также в случае локального проекта, разрабатываемого одним человеком. Возможно, только с той разницей, что вероятность несоответствия выше в первом случае.

Если у вас произошел сбой импорта XMI, сбой сети или другое непредвиденное событие, нарушающее целостность информации в модели, рекомендуется запустить функцию проверки целостности проекта, чтобы убедиться, что данные вашего проекта структурно завершены.

Вы можете выбрать различные элементы для проверки. При проверке целостности проверяются все записи базы данных и гарантируется отсутствие «осиротевших» записей, неточных или неустановленных идентификаторов. Эта функция НЕ проверяет соответствие UML, а только отношения данных и структуру репозитория.
Вы можете сначала запустить средство проверки целостности в режиме отчета, чтобы узнать, нужно ли что-то исправить, а затем снова запустить его в режиме «восстановить/очистить».

Когда Enterprise Architect «очищает» модель, он пытается восстановить потерянные пакеты и элементы и создает новый пакет на корневом уровне модели с именем _recovered_. Проверьте все найденные элементы и, при необходимости, перетащите их обратно на место. Если они не нужны, удалите их.
Выполним проверку через Configure > Model > Integrity > Project Integrity.
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По нажатию Save Results можно сохранить результаты проверки в виде текстового .log-файла.

2.11. Статистика проекта

Enterprise Architect располагает широким функционалом управления проектом.

На ленте «Construct» представлены инструменты и средства для визуализации и управления задачами и ресурсами, необходимыми для построения системы, от распределения человеческих ресурсов по задачам до мощных досок Канбан и диаграммы Ганта для визуализации хода выполнения работы. Команды могут сотрудничать непосредственно в инструменте и управлять широким спектром вариантов элементов модели, включая проблемы и дефекты, а также определять тесты и фиксировать результаты.
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Для просмотра статистики по содержимому проекта необходимо перейти в пункт: Construct > Project Management > QA
Нажмите на этот пункт, чтобы отобразить два варианта; во-первых, отобразить представление QA Report («Отчеты о контроле качества»), в котором есть отдельные вкладки, позволяющие запускать и отображать следующие системные отчеты о состоянии:

· Детали тестирования

· Сведения о техническом обслуживании

· Сведения о зависимости

· Детали реализации

· Метрики вариантов использования

Первый вариант предполагает широко документированный проект. Ограничимся в рамках лабораторной работы вторым вариантом.
Второй вариант - отобразить лист «Статистика проекта», в котором перечислены номера пакетов, диаграмм, элементов, соединителей, элементов каждого типа и характеристик элементов каждого типа в проекте. Для определенных элементов, таких как риски элемента, метрики и трудозатраты, если нет экземпляров этого конкретного типа объекта, он все равно отображается в списке, но с нулевым счетчиком.

Отобразим статистику проекта:
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2.12. Пример проектирования базы данных

Данный раздел посвящен ознакомлению с расширенными возможностями проектирования базы данных в среде Enterprise Architect.
2.12.1. Шаблон базы данных

Database Builder — это адаптированный интерфейс для средства моделирования данных; все задачи моделирования, связанные с базой данных, могут выполняться в одном месте. Интерфейс и связанные с ним экраны содержат только информацию, относящуюся к моделированию данных, что оптимизирует и упрощает процесс моделирования.
Для проектирования базы данных перейдите в Develop>Data Modeling>Database Builder. Создайте новую базу данных. В открывшемся окне выберите шаблон Basic PostgeSQL Model.
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Basic PostgreSQL Model

The Basic PostgreSQL Model patter creates elements and diagrams for modeling a database
including conceptual, logical and physical data models. It provides a basic model and package
structure and a number of pre-defined models and elements including database objects such as
Tables and Views that will provide a starting point. The physical data models can then be used

to generate DDL which can be executed using a defined connection to one or more live

databases.
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Шаблон Basic PostgreSQL Model создает элементы и диаграммы для моделирования базы данных, включая концептуальные, логические и физические модели данных. Он предоставляет базовую модель и структуру пакетов, а также ряд предопределенных моделей и элементов, включая объекты базы данных, такие как таблицы и представления, которые обеспечат отправную точку. Физические модели данных затем могут быть использованы для создания DDL, который может быть выполнен с использованием определенного соединения с одной или несколькими действующими базами данных.

Получаемый проект базы данных содержит исчерпывающий набор информации включающий в себя:

· Basic PostgreSQL Model – обзор основных разделов проекта базы данных;

· Traceability – порядок «эволюции» проектирования базы данных: таблица с инфологической модели (Concept A), с даталогической (Table A) и уже с диаграммы базы данных (TABLE_A);

· Conceptual Data Model – инфологическая модель;
· Logical Data Model – даталогическая модель;

· «Database» Database A – подробный проект базы данных, включащий в себя:

· Functions – функции (в соответствии с PostgreSQL);

· Queries – запросы;

· Sequences;

· Tables – таблицы и их диаграмму (по сути, даталогическую модель или диаграмму базы данных);

· Views – представления;

· Connections – связи с серверами баз данных;

· «EAReportSpecification» - шаблон генерации документации.
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2.12.2. Генерация DDL-сценария

Аналогичным образом сгенерируем DDL-сценарий, находясь в обозревателе на уровне папки «DataModel» Basic PostgreSQL Model.
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Обратите внимание, что, несмотря на нахождение указателя на более высоком уровне в обозревателе, среда автоматически находит пакет со стереотипом «database» и загружаем из него определенные элементы со стереотипами «table» и «view».
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CREATE VIEW "VIEW_A" AS
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2.12.3. Генерация документации

Создать документацию можно, кликнув ПКМ по шаблону «EAReportSpecification».
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По нажатию кнопки View можно посмотреть материал сразу внутри Enterprise Architect.
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3. КОНТРОЛЬНЫЕ ВОПРОСЫ

15. Для чего выполняется трассировка классов, подсистем?
16. Как выполняют проектирование класса? Что будет его результатом?
17. Как определяют и описывают атрибуты, операции, методы и связи классов?
18. Что такое прямое и обратное проектирование? Как оно выполняется?
19. Что такое инфологическая модель? Как ее создать?

20. Что такое даталогическая модель? Как ее создать?
21. Что такое DDL-сценарий? Как его сгенерировать?
22. Каким образом пакеты и класса анализа транслируются в подсистемы и классы проектирования? На что влияет стереотип класса анализа?

23. В чем цель проектирования подсистем?
24. Что такое документация проекта? Как создать ее?

25. Что такое проверка целостности проекта? Как ее автоматически выполнить?

26. Что содержит статистика проекта? Как ее посмотреть?
27. Для чего выполняется проектирование базы данных? Что содержит проект базы данных?
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5. ПРИЛОЖЕНИЕ 1
Описание пунктов генерации документации

	Пункт меню
	Описание

	Model Document 
Root Element 
Root Package 
	Проверьте имя элемента, выбранного в окне браузера, диаграмме, списке диаграмм, диспетчере спецификаций или поиске модели.

Если это специально созданный элемент Model Document для виртуального документа, полем будет 'Model Document'.

В противном случае в этом поле указывается выбранный элемент иерархии, по которому будет сообщено; то есть корневой элемент или корневой пакет.

	Output to File 
	Введите или выберите расположение и имя файла для созданной документации.

Нажмите на значок [image: image55.png]


 чтобы открыть проводник.

	Template 
	Щелкните стрелку раскрывающегося списка и выберите имя шаблона, который будет использоваться для отчета о документе.

Вы можете выбрать любой шаблон из выпадающего списка, который разделен на пользовательские (или пользовательские) шаблоны и системные шаблоны. Если вы загрузили технологию ЦРТ, содержащую шаблоны документов, они также перечислены под названием технологии.

Вы также можете сразу же создать новый шаблон, выбрав опцию «<новый шаблон>».

Система проверяет все папки шаблонов для указанного шаблона в порядке Пользовательские шаблоны > Шаблоны технологий > Системные шаблоны. Если под одним и тем же именем доступны разные шаблоны, система использует первый найденный в этой последовательности.

	Output Format 
	Нажмите на стрелку раскрывающегося списка и выберите формат вывода отчета. По умолчанию используется формат RTF (. RTF), но вы также можете выбрать:

Формат переносимого документа (.PDF) или

· Формат документов Майкрософт (.DOCX)

	Cover Page 
	Щелкните стрелку раскрывающегося списка и выберите название определения титульной страницы, которое будет применено к отчету по документу. 

В раскрывающемся списке можно выбрать любое определение, будь то стандартный формат или страница, разработанная пользователем. 

Используйте значение по умолчанию <none> , чтобы не включать титульную страницу или использовать титульную страницу, встроенную в выбранный пользовательский шаблон.

	Table of Contents 
	Щелкните стрелку раскрывающегося списка и выберите имя определения оглавления, которое будет применено к отчету о документе. 

В раскрывающемся списке можно выбрать любое определение, будь то стандартный формат оглавления или формат, разработанный пользователем. 

Используйте значение по умолчанию <none> , чтобы не включать оглавление или использовать оглавление, встроенное в выбранный пользовательский шаблон.

	Stylesheet 
	Щелкните стрелку раскрывающегося списка и выберите имя таблицы стилей, которая будет применена к отчету о документе. 

Из раскрывающегося списка можно выбрать любую таблицу стилей, будь то стандартное определение или набор пользовательских стилей. 

Используйте значение по умолчанию '<none>', чтобы не использовать таблицу стилей, а вместо этого применить стили, определенные в шаблоне, выбранном в поле 'Шаблон'.

	Diagram Theme 
	Щелкните стрелку раскрывающегося списка и выберите тему диаграммы, чтобы применить цвет, толщину линии и стиль шрифта к диаграммам элементов в отчете, если эти элементы используют значения по умолчанию. 

Если элемент имеет индивидуальный внешний вид, назначенный с помощью, например, диалогового окна «Внешний вид по умолчанию», этот внешний вид переопределяет параметры темы. 

Параметром по умолчанию является тема диаграммы, которую вы в настоящее время установили в своих «Локальных» параметрах. Однако вы можете выбрать любую другую тему только для этого отчета. После создания отчета параметр поля возвращается к теме по умолчанию.

	Suppress Sections 
	Нажмите на стрелку раскрывающегося списка и выберите из списка Профилей подавления, созданных вами или другими пользователями модели, на вкладке «Подавить раздел» диалогового окна «Создать документацию». 

Каждый профиль подавления определяет разделы отчета, которые могут быть опущены при создании текущего отчета. Это поможет вам адаптировать отчет для конкретной аудитории по генерации.

	Watermark 
	Введите местоположение изображения, которое будет использоваться в качестве водяного знака в документе, или нажмите на значок [image: image56.png]


 для открытия проводника.

	Wash image 
	Если выбрано изображение водяного знака, установите этот флажок, чтобы применить стирку к изображению перед его применением к документу. Это делает изображение светлее, чтобы оно не отвлекало от содержимого отчета, напечатанного поверх него.

	View Document On Completion 
	Установите этот флажок, чтобы открыть отчет о документе сразу после его создания.

	Use Language Substitutions 
	Установите этот флажок, чтобы включить подстановку слов на пользовательском языке. 

Снимите флажок, чтобы отключить подстановки слов на пользовательском языке.

	Markup Glossary Terms 
	Установите этот флажок, чтобы применить к созданному отчету RTF все стили, примененные к любым терминам глоссария через текст Notes элемента. 

Стиль применяется к термину глоссария в соответствии с его типом термина глоссария.

	Substitution of Glossary Terms 
	(Доступно, если выбран параметр Термины глоссария разметки.) 

Щелкните стрелку раскрывающегося списка и выберите тип термина. Для всех терминов глоссария такого типа, где бы термин ни встречался в докладе, он будет заменен его значением. 

Например, если вы выберете тип термина «издание», в отчете термины «Corp», «Uni» и «Ult» будут заменены значениями «Corporate», «Unified» и «Ultimate» соответственно.

	Use Internal Viewer 
	Установите этот флажок, чтобы включить кнопку Вид для запуска созданного документа во внутреннем средстве просмотра Enterprise Architect. 

Снимите этот флажок, чтобы включить кнопку Вид для запуска созданного документа в средстве просмотра файлов MS Windows по умолчанию.

	Include all Diagram Elements in Report 
	Установите этот флажок, чтобы включить в отчет элементы из внешних пакетов, на которые ссылается диаграмма, для каждой диаграммы, по которой выполняется поиск в отчете; флажок по умолчанию установлен. 

Чтобы включить внешние элементы в документ, установите также флажки 'Package.Diagram.Element' и 'Package.Element' в текущем шаблоне. 

Если внешние элементы должны быть включены только для определенных схем, снимите этот флажок и - только для схем, для которых вы хотите включить внешние элементы в отчет - для каждой схемы установите флажок "Документировать каждый содержащийся элемент в RTF" в свойствах схемы. 

Если оба параметра не выбраны или если ни один из флажков «Package.Diagram.Element» или «Package.Element» не установлен в шаблоне, документируются только элементы в текущем пакете.

	Progress 
	Отображение хода создания документа с помощью сообщений о состоянии и все более заполняемой строки состояния.

	Resource Document 
	Нажмите на эту кнопку, чтобы сохранить заданные параметры в виде определения документа.

	Open Template 
	Нажмите на эту кнопку, чтобы отредактировать выбранный шаблон с помощью редактора шаблонов документов. 

Вы можете редактировать только пользовательские шаблоны, а не стандартные шаблоны, поставляемые с системой. Если выбран системный шаблон, эта кнопка неактивна.

	Generate 
	Нажмите на эту кнопку, чтобы сгенерировать документ (после того, как вы установили все необходимые параметры, на всех вкладках диалогового окна).

	View 
	Нажмите на эту кнопку, чтобы запустить сгенерированный документ в: 

Средство просмотра файлов MS Windows по умолчанию, или

· Внутреннее средство просмотра Enterprise Architect, если установлен флажок "Использовать внутреннее средство просмотра"

	Abort 
	Нажмите на эту кнопку, чтобы отменить генерацию отчета; появится запрос на подтверждение отмены отчета.
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